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1. About this manual

1.1. Copyrights
The information in this document is subject to change without notice and should not 
be construed as a commitment by ABB Oy. ABB Oy assumes no responsibility for 
any errors that may appear in this document.

In no event shall ABB Oy be liable for direct, indirect, special, incidental or 
consequential damages of any nature or kind arising from the use of this document, 
nor shall ABB Oy be liable for incidental or consequential damages arising from use 
of any software or hardware described in this document.

This document and parts thereof must not be reproduced or copied without written 
permission from ABB Oy, and the contents thereof must not be imparted to a third 
party nor used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license 
and may be used, copied, or disclosed only in accordance with the terms of such 
license.

Copyright © 2006 ABB Oy 
All rights reserved.

1.2. Trademarks
ABB is a registered trademark of ABB Group. All other brand or product names 
mentioned in this document may be trademarks or registered trademarks of their 
respective holders.

1.3. Guarantee
Please inquire about the terms of guarantee from your nearest ABB representative.

1.4. General
This manual provides thorough information on the CAP 505, Relay Product 
Engineering Tools software and its applications. This document complies with the 
CAP 505 version 2.4.0.

Pictures shown are examples only and they may represent older program versions.

Additional information such as the Release Note and README.TXT can be found 
on the program distribution media.

ABB Oy regularly provides standard training courses on its main products. The 
training program is available on the Internet at 
http://www.abb.com/substationautomation. Please contact your ABB representative 
for more information.
9
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1.5. Use of symbols
This publication includes warning, caution, and information icons that point out 
safety related conditions or other important information. It also includes tip icons to 
point out useful information to the reader. The corresponding icons should be 
interpreted as follows:

Although warning hazards are related to personal injury, and caution hazards are 
associated with equipment or property damage, it should be understood that 
operation of damaged equipment could, under certain operational conditions, result 
in degraded process performance leading to personal injury or death. Therefore, 
comply fully with all warning and caution notices.

1.6. Abbreviations

The caution icon indicates important information or warning related 
to the concept discussed in the text. It might indicate the presence of 
a hazard which could result in corruption of software or damage to 
equipment or property.

The information icon alerts the reader to relevant facts and 
conditions.

The tip icon indicates advice on, for example, how to design your 
project or how to use a certain function.

HSB Hot Stand-By
LON Local Operating Network,

communication protocol developed by Echelon
POU Program Organization Unit
RTD Resistance Temperature Detector
SPA Data communication protocol developed by ABB
TCP/IP Transport Control Protocol/Internet Protocol; de facto 

communication protocol standard for data transmission over 
networks
10



1MRS752292-MUM CAP 505 
 
User�s Guide
1.7. Related documents

1.8. Document revisions

Name of the manual Document ID
CAP 505 Installation and Commissioning Manual 1MRS751901-MEN
CAP 505 Protocol Mapping Tool, 
Operation Manual

1MRS755277

CAP 505 Protocol Editing Tool, User�s Guide 1MRS751982-MUM
CAP 505 Relay Mimic Editor, User�s Guide 1MRS751904-MEN
CAP 505 SPTO Configuration Tool, User�s Guide 1MRS751906-MEN
LIB, CAP and SMS, Tools for Relays and Terminals, 
User�s Guide

1MRS752008-MUM

CAP 505 Relay Configuration Tool Tutorial 1MRS751903-MEN
CAP 505 Relay Configuration Quick Start Reference 1MRS751905-MEN

Version SW Revision number Date History
H 2.3.0-1 31.03.2004 Relay Download Tool,

REF 54x 3.0 additions
K 2.3.0-2 30.06.2004 Relay Download Tool, 

REX 52x additions
L 2.3.0-4 05.01.2005 Transducer Linearization Tool,

RET 54x additions,
Maintenance updates

M 2.3.0-5 01.03.2005 REC 52x 3.0 changes
N 2.4.0 07.02.2006 -SPA TCP/IP protocol added

-New chapter �Gateway object
 types (COM 610)�
-Maintenance updates
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2. Introduction

About this chapter
This chapter introduces CAP 505, its base system, operational features, user 
interface and functional description.

2.1. General
CAP 505, the Relay Product Engineering Tools software, is a Computer Aided 
Programming system for medium voltage relays in the RED 500 and SPACOM 
series.

CAP 505 provides you with the following tools:

� Project Structure Navigator for handling relays and tools.
� Relay Configuration Tool for configuration and programming of relays in the 

RED 500 series.
� Relay Mimic Editor for mimic configuration of relays in the RED 500 series.
� RED Relay Setting Tool for:

� Parametrization of RED 500 series of relays.
� SPA and LON communication.

� Graphical I/O Setting Tool for setting I/O related parameters of the REX 521 
relays.

� SPACOM Relay Setting Tool for:
� Parametrization of SPACOM series of relays.
� SPA communication.

� Project Export/Import Tool for project management.
� Communication Configuration page for setting communication parameters of the 

device objects.
� Relay Download Tool for up/downloading of configurations for RED 500 

terminals.
� Disturbance Recorder Collector Tool for uploading of disturbance records from 

the RED 500 series of relays. 
� SPTO Configuration Tool for monitoring and configuring the SPTO 1D2, 1D5, 

1D6 and 6D3 control modules of the SPAC feeder terminal series.
� Protocol Editing Tool for configuring the protocol object dictionary tables of the 

REC 52x relays prior to revision F.
� Protocol Mapping Tool for managing and editing the protocol mapping 

configuration of RED 500 terminals.
� Transducer Linearization Tool for setting input scaling/linearization data of the 

RTD/analog module (RTD1) in the RED 500 platform terminals.
� System Configuration Tool for configuring the projects' system configurations.
� Event Log Viewer for uploading and viewing event logs from the RED 500 

terminals.
13
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CAP 505 runs on various types and sizes of computers. It can be used both as a local 
system near the relay and as a central system connected to several relays. 
Communication with the relays is done through the relay�s front panel connector or 
the rear connector.

2.2. Operational features
This is a summary of functions provided by CAP 505:

� Product engineering (bay level)
� On-line and off-line engineering
� Framework for relay tools
� Project management
� Object oriented project data management
� Graphical programming for control and protection units
� Graphical programming for mimic panel
� Creation of documentation for the application program
� Generation of application program code
� Loading of program code, mimic configuration and parameters to the relay
� Loading parameters from the relay
� Loading of recorded values from the relay
� Edit history of parameters
� Comparison of present and saved values
� Uploading of disturbance records from the relay
� Uploading of event logs

2.3. User interface
The user interface of the CAP 505 system consists of the following components:

� Project Structure Navigator for tool selection and object management
� Project Export/Import for archiving and transfering projects

2.4. Base system
The CAP 505 system contains a base system and a communications system.

Supported communication protocols are:

� SPA, through COM-port and relay rear and front panel interfaces
� LON communication, through LonTalk adapters to the relay rear panel interface
� SPA TCP/IP, through Ethernet adapters to the relay rear panel interface

Supported LON communication cards are:

� PCC-10 PC Card
� PCLTA-20 Card
� RER 109 PCLTA Card (in Windows NT only)
14
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2.5. Applications
A station control and protection system contains a wide variety of components and 
functions. CAP 505 is a toolbox for handling data and tools during the relay 
engineering projects.

2.6. CAP 505 tools
System Configuration Tool

The System Configuration Tool is used for configuring the projects' system 
configuration to enable communication with the relays.

This tool is documented in the CAP 505 Installation and Commissioning manual.

Project Export/Import Tool

The Project Export/Import Tool is used for project management purposes like 
deletion, duplication, and creation of projects. In addition to this, the tool is used 
when a project is to be transferred to another system or brought into the current  
collection of projects.

This tool is documented in Chapter 5. Project Export/Import Tool in this manual.

Relay Configuration Tool

The Relay Configuration Tool is used for configuring the functions of protection, 
control, condition monitoring, measurement and logics.

The Relay Configuration Tool is based on the IEC 1131-3 standard, which defines 
the programming language that is used for relay terminals. The programmable 
system of the RED 500 series of products allows the output contacts to be operated 
in accordance with the state of the logic inputs, the outputs of protection, control, 
measurement and condition monitoring functions. The control logic (e.g. 
interlocking and alarm logic) is programmed with Boolean functions, timers, 
counters, comparators and flip-flops. The programming languages are: function 
block diagram language, state function chart diagram language or instruction list 
language.

This tool is documented in the Relay Configuration Tool Tutorial and Relay 
Configuration Quick Start Reference.

Protocol Mapping Tool (PMT)

The Protocol Mapping Tool is used for creating and editing the protocol mapping 
configuration, which is a cross-reference table between the application and the 
communication protocol. This table defines what information can be accessed from 
the device by using the protocol interface.

The Protocol Mapping Tool uses the relay configuration project to create a mapping 
for a given application. After a mapping has been created, the user can modify it by 
removing or adding some points, changing their order and creating protocol 
compositions, such as user defined registers (bit-field and analog) or control 
structures.

This tool is documented in the Protocol Mapping Tool manual.
15
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Protocol Editing Tool (POD)

The Protocol Editing Tool is an engineering tool for protocol table configuration of 
REC 52x relay terminals. Protocol tables can be read from and written to the target 
device and also stored onto the hard disk. The tool allows to maintain a user library 
of protocol tables on a per-project basis. The engineering work can thus be based on 
the user library or standard templates, which comprises the protocol descriptions 
that are shipped with the REC 52x object type.

Signal-level protocol table modification is provided with functions such as Insert 
signal, Remove signal and Move signal. Attribute values of signals can be edited 
within the limits of the specified values. Protocol table signals can be listed in 
alphabetical order of the signal identification, address, data type or function block 
order.

In addition, the Protocol Editing Tool produces the information necessary for event 
handling configuration in the MicroSCADA system.

This tool is documented in the Protocol Editing Tool manual.

Transducer Linearization Tool

The Transducer Linearization Tool is a tool for setting input scaling/linearization 
data of the RTD/analog module (RTD1) in the RED 500 platform terminals. Input 
scaling/linearization is needed when non-linear sensors, not directly supported by 
the RTD/analog module, are used. Linear/non-linear scaling is done to each RTD/
analog input separately. The tool is available only for certain RED 500 platform 
terminals.

This tool is documented in Chapter 11. Relay Download Tool for REX 52x in this 
manual.

Relay Mimic Editor

The Relay Mimic Editor is used for configuring the graphical display and the alarm 
channels of the feeder terminal. The MIMIC configuration may include circuit 
breakers, disconnectors, indicators, measurement data objects and user-defined texts 
and explanations.

Alarm function blocks can be configured in the same alarm view of the MIMIC 
editor. ON and OFF state texts and LED colours can be defined.

This tool is documented in the Relay Mimic Editor manual.

Relay Setting Tool

The Relay Setting Tool is used for parametrization of the relay units. The parameters 
can be set off-line in a PC, and downloaded to the relay or uploaded from the relay.

The Relay Setting Tool menu structure including views for parametrization are the 
same as the views on the technical level of the local HSI (Human System Interface) 
for the relays in the RED 500 series.

It is also possible to set parameters in relays in the SPACOM series.

This tool is documented in the Tools for Relays and Terminals manual.
16
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Graphical I/O Setting Tool

The Graphical I/O Setting Tool is used for graphical setting of digital inputs, digital 
outputs and alarm LED signals of the REX 521 relays. These I/O related parameters 
can be set off-line in a PC, and downloaded to the relay or uploaded from the relay.

The Graphical I/O Setting Tool is complementary to the RED Relay Setting Tool; a 
change of parameter setting in the Graphical I/O Setting Tool will be visible in the 
RED Relay Setting Tool, and vice versa.

This tool is documented in the Tools for Relays and Terminals manual.

Relay Download Tool

The Relay Download Tool is used for sending configurations and mimic pictures to 
the relay, and for storing configurations to non-volatile memory and for restarting 
the relay software.

This tool is documented in Chapter 10. Relay Download Tool for REF 54x/REM 
54x/ REC 52x/RET 54x and Chapter 11. Relay Download Tool for REX 52x in this 
manual.

SPTO Configuration Tool

The SPTO Configuration Tool targets the control modules SPTO 1D2, SPTO 1D5, 
SPTO 1D6 in SPAC 300 series and SPTO 6D3 in the SPAC 500 and 600 series in 
the SPACOM range of products.

The tool can be used to configure the SPTO 1D2, 1D5, 1D6 in the SPAC 300 series, 
when the built-in factory default setting groups in the modules cannot be benefit 
from, or whenever it is desirable to make an own configuration.

This tool is documented in the SPTO Configuration Tool manual.

Communication page

The Communication page is used for configuring the communication settings of the 
device objects.

The communication page is documented in the Tools for Relays and Terminals 
manual on a per-object type basis.

Disturbance Recorder Collector Tool

With the DR-Collector Tool, disturbance records can be uploaded from the RED 500 
and SPACOM series of relays. The supported recording file format is COMTRADE.

The Relay Setting Tools for RED 500 and SPACOM are documented in the Tools 
for Relays and Terminals manual.

Event Log Viewer

The Event Log Viewer is used for uploading and viewing event logs from the 
RED 500 terminals. An event log is a snapshot of the current events in the event 
view of the connected terminal.

This tool is documented in the Tools for Relays and Terminals manual.
17



18



1MRS752292-MUM CAP 505 
 
User�s Guide
3. Quick start example

About this chapter
This chapter discusses the basic steps for getting started with CAP 505 and is 
intended to serve as an introductory reading to users not familiar with CAP 505.

The quick start example:

� Guides you through the process of constructing a representation of a simple 
station with three bays with RED 500 and SPACOM relays, familiarizing you 
with basic functions such as adding, configuring and moving objects in a project.

� Illustrates one solution to organize the project by means of user views.

In this example it is assumed that you have completed commissioning of the CAP 
505 software, which is explained in the CAP 505 Installation and Commissioning 
Manual.

3.1. Projects
CAP 505 supplies an initial empty project titled SOST. Initially, the SOST project 
is set as the default project, meaning that this project will contain the new objects 
unless another project is explicitly created and opened, using the Project Export/
Import Tool. For detailed information on working with CAP 505 projects, see 
Chapter 5. Project Export/Import Tool

3.2. Views
The Project Structure Navigator provides the possibility to define different view 
contexts. This feature makes it possible to group the inserted objects arbitrarily, 
which is a useful feature when the number of inserted objects is large. For detailed 
information on working with project views, see Section 4.9. Views menu.

3.3. Object types
There are three main categories of object types, i.e. level object types, device object 
types and compound object types.

The level object types are used for building the structure of the projects and their 
views.

The device object types are used when a physical device shall be configured. For 
example, REF 54x is a device object type.

Compound object types combine the behaviour of both the level and device object 
types. In essence, compound object types participate in project's structurization but 
they also have configurable properties, similar to the device object types. For 
instance, you can use Station and Bay objects to build a representation of a station 
and its bays. Another example, is the communication gateway object types, e.g. LSG 
(LON/SPA Gateway). Device objects can be hosted by a gateway object, for which 
you define correct communication settings to enable communication through the 
gateway.
19
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3.4. Object type groups
Each object type belongs to one named object type group, which provides similar 
functionality.

Four object type groups are available:

User Structure Object types of this group serve the purpose of project 
structurization.

Plant Structure Object types of this group serve the purpose of project 
structurization.

Gateway Object types of this group serve the purpose of project 
structurization and representation of communication 
gateway devices.

Protection & Control Object types of this group serve the purpose of 
representing protection and control devices.

3.5. Starting CAP 505
To start CAP 505, select the Start CAP 505 icon from the program folder created by 
the CAP 505 installation program. The Project Structure Navigator with the default 
project opened in the Master Design View mode appears. 

3.6. Insertion of objects
In this section, you begin by inserting four RED 500 device objects and one 
SPACOM device object to the project. Then you add a simple representation of a 
station with three bays, illustrating how to move the device objects in the project 
structure.

Device object insertion

At this point, your project contains only the abstract root node, which is titled Root. 
Click on the root node with the mouse, so the navigator knows where to insert the 
new object in the project structure. Next, choose Insert Object on the navigator's Edit 
menu, after which the Add Project Object dialog appears on the screen.

Fig. 3.6.-1 Inserting a new object to the project

This dialog displays the object type groups and the object types present in the 
system. As you are now inserting a device object, the interest group is Protection & 
Control, which groups the RED 500 series and SPACOM series object types.
20
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To insert a device object representing a REF 54x relay terminal of the RED 500 relay 
series, click on the Protection & Control list item. As the result, you are viewing the 
list of Protection & Control object types. The first available object type is 
automatically selected, as shown in Fig. 3.6.-2.

add_proj_obj

Fig. 3.6.-2 Selecting the type of the object

The appropriate object type (REF 54x) is already selected. To insert it, click OK, 
which opens the New Object's Properties dialog for entering the object's name and 
title.

Fig. 3.6.-3 Entering the name and title for the object

Type in the name and title and click OK. The dialog closes and the object is inserted 
under the root node. The object's title is displayed in the project views. Now your 
project should look like the one shown in Fig. 3.6.-4.
21



1MRS752292-MUM 
 
User�s Guide

CAP 505
qs3_1

Fig. 3.6.-4 The inserted REF 54x device object in the project's view

Repeat this insertion procedure twice, specifying 'OUT1' and 'OUT2' as the names 
and 'Protection and control' as the titles for both of the objects. These new REF 54x 
objects will also be inserted under the project's root node, since the project does not 
yet contain any compound objects being able to host the device objects. Your project 
should now look like the one shown in Fig. 3.6.-5.

qs4_1

Fig. 3.6.-5 Three REF 54x device objects in the project

Now you have three REF 54x device objects in the project. As you may recall, the 
aim is to also insert a device object of the SPACOM type.

To accomplish this, repeat the insertion procedure with the exception: select the 
SPACOM object type from the Protection & Control group. For the object's name 
and title, specify 'INCOMER2', 'Differential protection'. When you are ready, the 
project should look like the one shown in Fig. 3.6.-6.
22
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qs5_1

Fig. 3.6.-6 Four device objects in the project's view

Notice that in terms of usability, these newly inserted device objects are somewhat 
abstract, since they lack essential information about the physical relay terminals they 
represent. In practice, these objects need to be configured before they can be used 
(the configuration procedure is explained later).

As you now have some device objects, you can advance to add compound objects to 
the project to organize the contents of the project.

Compound object insertion - Plant Structure

Next, you will build a simple representation of a station with three bays.

Start by selecting the project's root node that will be the insert-location for the 
Station object. In fact, the only location where you can insert a Station object is the 
project's root node.

In the Edit menu, choose Insert Object to bring up the Add Project Object dialog. 
Since the Station object type belongs to the Plant Structure group, select the Plant 
Structure group as shown in Fig. 3.6.-7.

Fig. 3.6.-7 Selecting the Station object type
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To have the Station object inserted, click OK. The dialog that now appears for 
entering attributes for the object, is specific for insertion of Plant Structure objects, 
as illustrated in Fig. 3.6.-8. Enter 'Eastwick' as the object's title and 'STA1' as its 
name.

Fig. 3.6.-8 Inserting a Plant Structure object - Station

Click OK to insert the station object. Now your project should look like the one in 
Fig. 3.6.-9.

qs8_1

Fig. 3.6.-9 The new Station object in the project's view

Now you have a Station object capable of hosting the bays. Next, you will insert 
three Bay objects under the station. Eventually, the project's device objects will be 
moved under these bays.
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As the station will be the parent for the bays, select the Station object to set the 
correct insert-location.

Invoke the Add Project Object dialog. The navigator is aware of the currently 
selected object's type (Station) and displays the available object type groups and 
object types accordingly (see Fig. 3.6.-10).

Fig. 3.6.-10 Selecting the Bay object type

To insert the object, click OK and specify the name and title as in Fig. 3.6.-11.

Fig. 3.6.-11 Specifying the name and title for the Bay object

Next, add two bays similarly, specifying 'Bay2', 'Bay3' and 'Outgoing 1', 'Outgoing 
2' as their names and titles. Now your project should look like the one shown in 
Fig. 3.6.-12.
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Fig. 3.6.-12 The station hosting three bays

Now you are ready to organize the project further by moving the device objects to 
more appropriate locations in the project structure.

3.7. Moving objects in the project
In this section, the existing device objects are moved to a new location in the project 
structure.

Fig. 3.7.-1 illustrates the intended final organization of the device objects in the 
Master Design View.
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Fig. 3.7.-1 Objects in their final locations

The procedure for moving objects in the project's views consists of the following 
steps:

1. Select the object you intend to move by clicking on it with the mouse.
2. On the Project Structure Navigator's Edit menu, select Object Properties to 

bring up the General Object Attributes dialog.
3. Click Move on the General Object Attributes dialog to bring up the Move 

Object dialog.
4. From the project structure, select the target compound object, which will host 

the moved object.
5. Click Move Here on the Move Object dialog to move the object to the selected 

target location.

Following this procedure, move the objects one at a time to the locations shown in 
Fig. 3.7.-1. Notice that moving a device object under a bay object, causes the station 
node to collapse. A collapsed node is expanded by either double-clicking on it or by 
clicking on the plus sign (+) on the node's left hand side.

3.8. System configuration
The system communication should also be configured at some point. It has to be 
done before you configure the communication settings on device (relay) level, see 
Fig. 3.9.2.2.-3. You need to make the basic communication definitions for the serial 
ports and LON channels. From the System Tools menu, select item System 
Configuration and page Communication, see Fig. 3.8.-1
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Fig. 3.8.-1 Setting up the serial ports

How to set up the LON channel is described in the CAP 505 Installation and 
Commissioning manual.

Use the Add button to add serial port. Usually the default settings are sufficient. 
Press OK to save and to exit.

Next, we will advance by configuring the project's device objects.

3.9. Configuration of device objects

3.9.1. General
Prior to using an inserted device object, the object must be configured. Otherwise, 
attempts to launch an object tool result in notifications requesting you to configure 
the object.

For instance, configuring a REF 54x device object means that the object is assigned:

1. The software configuration (SW), which is a set of hardware dependent files. 
The software configurations are supplied solely by ABB.

2. The application (Apl) configuration, which is a set of application dependent 
files. An application configuration is either supplied by ABB or created within 
the CAP 505/501 environment, which is why it has been saved into the 
application library of the object�s object type.
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3.9.2. Relay configuration procedure
A device object is configured in the Master Design View by means of a dialog, 
which is dependent on the device object's type. The configuration procedure 
comprises the following steps:

1. Select the device object in the project structure.
2. Select Object Properties on the Edit menu to open the General Object Attributes 

dialog for the object or press <Alt>+<Enter> on the keyboard. You can use the 
Properties button as well, see Fig. 3.9.2.-1.

Fig. 3.9.2.-1 The Properties button

3. Click Attributes to open the object�s configuration dialog, see Fig. 3.9.2.-2.

Fig. 3.9.2.-2 General page for INCOMER1

3.9.2.1. RED 500 relay object types
1. In the SW library, select the SW configuration that matches the relay terminal 

that is to be used.
2. Select an application in the Apl library, or if the application is unknown, some 

of the RED relay object types allow uploading of the configuration from the 
relay terminal. The uploaded configuration is available for selection in the Apl 
library list.

Close the object's configuration dialog by clicking OK to return to the General 
Object Attributes dialog. For more information on configuring device objects, see 
the Tools for Relays and Terminals manual.
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Configuring the quick start device objects
To proceed with the example, you need to configure the device objects in the order 
they appear in the project. Once you are done, the objects are configured as shown 
in Table 3.9.3-1.

To proceed, select the device object INCOMER1 which is titled �Incomer protection 
and control.� On the Edit menu, select Object Properties to bring up the General 
Object Attributes dialog. The tabbed page titled General is active, displaying general 
information on the object. Notice that in this dialog you can change some of the 
object's attributes in the Master Design View. Which attributes are changeable, 
depends on the object's type.

To configure the REF 54x device, click Attributes and you enter the REF 54x 
Configuration dialog (shown in Fig. 3.9.2.1.-1).

conf_device_obj

Fig. 3.9.2.1.-1 The configuration dialog for REF54x device objects
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Assigning the software configuration
As stated in Table 3.9.3-1, this object's software configuration should be REF543-
1MRS118501 rev. F, thus the software configuration suggested by default, has to be 
changed. In the dialog's upper area, the Select New check box is checked, allowing 
you to select the appropriate software configuration.

To change the configuration, select the configuration named REF543-1MRS118501 
from the list titled �SW library� and select revision F from the list titled Rev.

Assigning the application configuration
To complete this object's configuration, you need to assign the intended application 
configuration for the object, in this example it is 1MRS114502 revision A.

To assign it, select the application configuration 1MRS114502 from the list titled 
Apl library and the revision A from the list titled Rev. Next, click OK to apply the 
configuration, saving it to the project database. Now you returned to the General 
Object Attributes dialog, close it by clicking OK.

Uploaded application configurations in REF 54x, REM 54x, REC 52x and RET 
54x object types

The REF 54x, REM 54x, REC 52x and RET 54x object types provide an alternative 
of using an application configuration, which you can upload from the relay terminal. 
Upon completion of the upload, you save the uploaded configuration into the object 
type's user application library. These application configurations are stored without 
revision information and are available through the Apl library list, shown in 
Fig. 3.9.2.1.-1. The use of uploaded application configurations is outlined below: 

1. Insert the device object to the project.
2. Configure the object as explained above, assigning an empty application 

configuration. Eventually you will replace it with the uploaded configuration. 
Apply the configuration normally and then return to the Project Structure 
Navigator.

3. Reopen the General Object Attributes dialog selecting the Communication page 
to provide communication settings for the object. Select the communication 
protocol and configure the communication settings. Connect the communication 
cable, if it has not been done yet.

4. Open the object type's configuration dialog. Click Apl Utils� and you enter the 
dialog for maintaining the user application library.

5. By clicking Receive, the upload starts bringing up a progress indicator dialog. 
Upon completion of the upload, you provide the name for the uploaded 
configuration. This name will appear in the Apl library list.

6. Close the user application library management dialog by clicking Close. Now, 
to assign the newly uploaded application configuration, check the Select New 
check box and select the configuration from the Apl library list.

7. Close the object type's configuration dialog by clicking OK. You are prompted 
to confirm the replacement of the application configuration. Click Yes to 
enforce the new configuration.

To proceed with the example, configure the other two REF 54x device objects 
(OUT1 and OUT2) by using Table 3.9.3-1 as reference.
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3.9.2.2. SPACOM relay object types
At this point, the SPACOM device object (INCOMER2) is still not configured. To 
configure it, enter the object's configuration dialog as you did with the REF 54x 
objects. The configuration dialog that appears on the screen, differs from the one you 
used for the REF 54x objects, see Fig. 3.9.2.2.-1.

Fig. 3.9.2.2.-1 The configuration dialog for SPACOM device objects

Now, locate the module named SPAD 346 from the Modules list and click Add −> 
when you have selected the module. The dialog should look like the one shown in 
Fig. 3.9.2.2.-2.
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Fig. 3.9.2.2.-2 The selected SPACOM configuration

To apply the configuration, click OK and you return to the General Object Attributes 
dialog.

Before you can make the communication setup for the individual objects, you have 
to set up the system configuration as described in Section 3.8. System configuration. 
Alternatively, you can click the System Configuration button in the General Object 
Attributes dialog (see Fig. 3.9.2.2.-3), which brings up the System Configuration 
dialog (see Fig. 3.8.-1). 

Fig. 3.9.2.2.-3 Communication addresses for some modules using SPA protocol

After having configured the system, you can make the communication setup for the 
devices. The presentation may vary depending on the selected device
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3.9.3. Summary
For example, the following devices with the following configuration have been 
added to the project: 

At this stage, you have almost completed the example. Next, you can familiarize 
yourself with the use of user views in projects. Remember that regarding views, the 
example project contains only the Master Design View, which is the only view 
allowing you to insert device objects to the project and configure them.

3.10. Using user views
General

No specific rules for the use of user views exist in regard to their logical contents or 
amount.

Creating user views

In this example, you will create two rather self-explanatory user views: one named 
Outgoing and another named Incoming. You will also populate these views with the 
previously inserted device objects appropriately.

To proceed building the example project, select Create view on the Views menu of 
the Project Structure Navigator. This opens the Project View Properties dialog 
shown in Fig. 3.10.-1.

qs16_1

Fig. 3.10.-1 Entering information for the new user view

Table 3.9.3-1 Example device configuration

REF 54x device SW Configuration Apl Configuration
INCOMER1 REF543-1MRS118501 rev. F 1MRS114502 rev. A
OUT1 REF541-1MRS118500 rev. C 1MRS114501 rev. A
OUT2 REF541-1MRS118500 rev. C 1MRS114501 rev. A

SPACOM device Relay Description
INCOMER2 SPAD 346
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Specify the information for the view as shown in the figure above. You can later 
change these properties of views, by selecting the View Properties menu item on the 
Views menu. Click OK to create the view. The Navigator opens the view 
immediately. Notice that the Views menu now contains this newly added view 
below the Master Design View menu item.

Next, add the other user view similarly and specify 'Outgoing' for the view's 
properties. Now your Views menu should contain the menu items shown in 
Fig. 3.10.-2.

Fig. 3.10.-2 User view menu items in place

Adding objects to a user view

Final step of this example is to populate the user views with the device objects.

The procedure for adding objects to user views is simplified compared to Master 
Design View, since the objects have already been assigned names and other basic 
information.

If the Outgoing view is not currently active, activate it by selecting the Outgoing 
menu item on the Views menu. Now, select Insert Object on the Edit menu to bring 
up the Add object from Master Design View dialog (see Fig. 3.10.-3). The dialog 
lists all the device objects that exist in the project, displaying both the titles and the 
names of the objects. Object names are displayed in parentheses.

Fig. 3.10.-3 List of objects in Master Design View

Notice the Add Level button in the dialog. By clicking this button, you can add Level 
objects to the user view for organizing the view's contents.

The intention is to add the objects OUT1 and OUT2 into this view. Select the object 
named OUT1 from the list and click OK to add the object closing the dialog. The 
contents of the view should now be as shown in Fig. 3.10.-4.
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Fig. 3.10.-4 Object OUT1 in place

Similarly, add the object named OUT2 to this view.

Next, switch the view by selecting the Incoming menu item on the Views menu. Add 
the remaining device objects INCOMER1 and INCOMER2 to this view.

3.11. Launching object tools
Object tools are launched as follows:

1. Select the target device object in the project. Object tools are available in all 
views of a project.

2. Double-click on the object tool on the Object Tools list or
3. Select the tool from the Object Tools list and press <Enter> on the keyboard.

The Project Structure Navigator allows a single object tool to be used at a time. 
Documentation for each CAP 505 tool is supplied; the documentation is listed in the 
Release Note.
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4. Project Structure Navigator

About this chapter
This chapter describes the elements and functionality of the Project Structure 
Navigator.

4.1. General
The Project Structure Navigator is your workspace for managing data and tools. It 
provides you with access to the CAP 505 tools and project-based object-oriented 
data-management.

4.2. Projects
In CAP 505, projects are the containers for object-oriented data management and 
storage. Projects allow you to build representations of power stations and their 
protection and control devices. The maximum number of projects in CAP 505 is 
limited only by the available disk space on your computer.

The navigator allows you to build projects and operate these by means of a 
hierarchical tree structure. The structure is comprised of nodes where each node is 
an instance of an object type. Initially, all projects are empty, meaning that the 
project tree contains only one node (root level) that gives a starting point to build the 
project upon.

The Project Structure Navigator works in one of two modes, the Master Design 
View mode, or the User View mode.

4.2.1. Master Design View
The Master Design View allows insertion of all available object types in CAP 505. 
It is the only view, in which you can:

� Insert objects to the project
� Configure the objects
� Configure the communication settings of the objects

The device objects are also available for use in the user views. The Master Design 
View is a built-in view meaning that it is always available in every project and 
cannot be deleted.

4.2.2. User Views
User views are intended for designing browsable operator views, e.g. for showing 
only objects with importance to the user. The object hierarchy in a user view may 
differ from the one in the Master Design View. Object types of the User Structure 
object types group provide you with the means of arranging the hierarchy of user 
views. The device objects, that are available in the Master Design View, can be 
inserted into the user views.
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4.3. Object types
The Project Structure Navigator handles three types of objects:

Level object types Level object types serve as structurization items in a 
project. A level object type does not set restrictions on 
what object types can be inserted underneath it. In many 
respects, levels behave like directories in a file system 
since directories may contain files and subdirectories. An 
example of level object type is the Level type.

Device object types Device object types control physical devices. A device 
object stores parameters about physical hardware, e.g. a 
REF 541 terminal.

Compound object types Compound object types combine the behaviour of level 
and device object types. In a project, a compound object 
has both object properties and structurization properties. 
As the result, a compound object has private object 
settings and a view level, under which it is possible to 
insert objects of object types allowed by the object type. 
The main difference between views of a level object type 
and a compound object type is that compound object types 
set restrictions on what object types can be represented in 
its views. Examples of compound object types are plant 
structures and communication gateways.

4.4. Object type groups
Each object type belongs to one named object type group, whose member types 
provide common functionality.

Four object type groups are available:

User Structure Object types of this group serve the purpose of project 
structurization. Contains level object types only.

Plant Structure Object types of this group serve the purpose of 
MicroSCADA compatible project structurization. 
Contains compound object types only.

Gateway Object types of this group serve the purpose of project 
structurization and representation of communication 
gateway devices. Contains compound object types only.

Protection & Control Object types of this group represent protection and control 
devices. Contains device object types only.

4.5. User interface
Access to the various tools and functions is provided by means of a tool bar, menus 
and keyboard shortcuts. Fig. 4.5.-1 illustrates the Navigator�s user interface and its 
elements.
38



1MRS752292-MUM CAP 505 
 
User�s Guide
psn_1

Fig. 4.5.-1 The user interface of the Project Structure Navigator

User interface elements
Caption bar Displays the name of the current view. In Fig. 4.5.-1, it is 

the Master Design View. It also contains the standard 
operating system�s window management commands for 
minimizing, maximizing and closing the window.

Menu bar File, Edit, Views, System Tools and Help menu.
Tool bar The tool bar contains shortcuts for quick access to the 

frequently used functions.
Object tools list An object selection sensitive list of object tools that are 

available for the object currently selected in the project 
structure.

Structure Displays the objects in the current project view for object 
selection and navigation.

Status bar Displays the path of the current project and the type of the 
object, currently selected in the project structure.
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The following icon symbols are used for different object type groups in the project 
view:

4.6. Entering the Project Structure Navigator
CAP 505 is started by selecting the shortcut "Start CAP 505" from the CAP 505 
program folder and pressing <Enter> or double-clicking on the shortcut. This starts 
the MicroSCADA service bringing up the Project Structure Navigator window.

Notice that if you attempt to start a second instance of CAP 505 which is not 
allowed, you are notified that CAP 505 is already running (see Fig. 4.6.-1).

Fig. 4.6.-1 Notification that CAP 505 is already running

Dismiss the notification by clicking OK.

4.7. File menu
The File menu contains the project handling functions and Exit.

File_menu

Fig. 4.7.-1 The File menu

4.7.1. File Open
Keyboard entry: <Ctrl>+<O>

Table 4.5.-1 Symbols for different object type groups

User Structure or Plant Structure

Gateway

etc. Protection & Control
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Tool bar entry:

By selecting this menu alternative, the currently open project is closed and the Open 
Project dialog is opened.

Fig. 4.7.1.-1 The Open Project dialog

To open a project into the Navigator view, first select the project and then click 
Open. This also enforces the project's system configuration, which you can view and 
modify by means of the System Configuration Tool.

4.7.2. File Close
This alternative closes the currently open project.

4.7.3. Organize Projects
When selecting this alternative, the Project Export/Import Tool is started. For more 
information on the tool, see Chapter 5. Project Export/Import Tool.

4.7.4. File History List
The File menu includes a file history list of the previously opened projects. It helps 
to quickly open some recently used local project.

The five last opened projects (if any) are listed and sorted so that the last used project 
is the first name on the list. By clicking the project name or by entering the order 
number from the keyboard, the currently open project is closed and the requested 
project is opened.

4.7.5. Exit
Keyboard entry: <Alt><F4>

By selecting this alternative CAP 505 is closed and MicroSCADA service stopped.

To close CAP 505, click Exit on the CAP 505 Login window. This 
will stop the MicroSCADA service.
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4.8. Edit menu
The edit menu contains functions for adding and deleting objects and for invoking 
the General Object Attributes dialog for the currently selected object.

Accessibility to the menu items depends on the currently selected object. For 
instance, the Delete Object item in Fig. 4.8.-1 is disabled, indicating that the 
currently selected object cannot be deleted.

Fig. 4.8.-1 The Edit menu

4.8.1. Insert Object
Keyboard entry: <Insert>

Tool bar entry: 

By clicking this menu alternative you initiate the insertion of objects in the project.

Insert Object in the Master Design View

When you select the Insert Object function in the Master Design View, the Add 
Project Object dialog (shown in Fig. 4.8.1.-1), appears on the screen allowing you 
to specify the type of the object to be added to the currently selected location.

Fig. 4.8.1.-1 Insertion of an object

The Project Structure Navigator displays all the object type groups currently 
available in the CAP 505 environment. However, the object types of these groups 
are filtered according to the currently selected object, which will host the new object.

To insert the object, first choose the appropriate object type group. Select the type 
for the new object and click OK to enter the dialog, where you give the basic 
properties for the new object (see Fig. 4.8.1.-2). Notice that this dialog varies 
according to the type of the new object.
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Fig. 4.8.1.-2 Provide properties for the new object

Type in the title and the name for the object and click OK to complete its insertion.

Fig. 4.8.1.-3 The limitation of project object instances is exceeded

Insert Object in the user views

When you select the Insert Object function in a user view, the �Add object from 
Master Design View� dialog appears on the screen, allowing you to select the object 
to be added to the currently selected location.

If you omit the name, the Project Structure Navigator uses a 
generated name. You can change both of these properties later by 
means of the General Object Attributes dialog. The title is a property 
by which you will identify the object in the project views.

The maximum number of STA objects in a CAP 505 project is 
limited to a total of two hundred (200). One object instance can 
reserve more than one STA object, so the actual maximum object 
count in a project may be smaller than 200. If you try to add more 
than 200 objects, the following notification dialog will be shown:
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Fig. 4.8.1.-4 Inserting a device object to a user view

To insert a device object, choose it from the object list and click OK to close the 
dialog.

This dialog also allows you to insert Level objects, which you can use for organizing 
the contents of the user view. This is accomplished by clicking the Add Level button 
(see Fig. 4.8.1.-4). 

To insert a Level object, either select the root node of the view or another Level 
object. Then, click Add Level to enter the dialog for providing the title of the object 
(see Fig. 4.8.1.-5).

Fig. 4.8.1.-5 Inserting a Level object to a user view

Provide a unique title in the view's scope and click OK to close the dialog.

4.8.2. Delete Object
Keyboard entry: <Delete>

Toolbar entry:

To delete the currently selected object, use this function. You can delete only such 
objects, which do not contain any subordinate objects.

All device objects that you have inserted in the Master Design View 
are available for selection. However, you can insert a device object 
only once to a given user view.
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If you are working in a user view, the deleted object remains in the project database 
and it can thus be re-added to any user view in the project. However, deleting an 
object from the Master Design View permanently removes the object from the 
project database, which in essence means erasing the object�s file storage from the 
hard disk. Regarding device objects, deletion automatically causes the object to be 
silently removed from any user views.

4.8.3. Object Properties
Keyboard entry: <Alt>+<Return>

Tool bar entry:

To bring up the General Object Attributes dialog for the currently selected object, 
use this menu item.

Notice that if you select the root node, this function brings up the dialog for changing 
and viewing properties of the project (in the Master Design View) or properties of a 
user view (in a user view).

4.8.3.1. General Object Attributes dialog
The General Object Attributes dialog is a central tool for project object management. 
The dialog contains two tabbed pages; General and Communication for setting and 
viewing object's attributes. The General page is available for all objects in all views, 
whereas the Communication page is displayed only in the Master Design View for 
objects that require communication settings. With the dialog's buttons, you invoke 
the object's configuration dialog, if supported by the object type, and the dialog for 
moving the object in the project hierarchy.

The Communication page is not documented here. For detailed 
information on configuring the communication settings, refer to the 
respective object type's configuration guide (e.g. the Tools for 
Relays and Terminals manual).
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Fig. 4.8.3.1.-1 The General Object Attributes dialog

Table 4.8.3.1-1 General Object Attributes dialog items

General page
Object Title A read/write attribute in the Master Design View, read-only in user 

views. 
Object Name A read/write attribute in the Master Design View, read-only in user 

views. 
Object Type The type of the object, read-only in all views.
Version The version of the object's type, read-only in all views.
Group The group of the object's type, read-only in all views.
Remarks Remarks on the object. A read/write attribute in the Master Design 

View, read-only in user views. 
Note! Data is automatically truncated to 253 characters without notice.

Buttons
OK Closes the dialog saving the changes to the object's general 

attributes. 
Cancel Closes the dialog discarding the changes to the object's general 

attributes.
Note! This button does not have any impact on changes to the 
object's configuration.

Attributes Invokes the dialog for configuring the object. Enabled in Master 
Design View only, on condition that the object's type supports object 
configuration, otherwise this button is disabled. 

Move If the object's type supports moving objects, this button invokes the 
dialog for moving the object within the current view. Otherwise this 
button is disabled. For details on moving objects, see Section 4.8.3.2. 
Moving objects 
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4.8.3.2. Moving objects
Objects can be moved only within the current view. The procedure involves using 
the Move Object dialog (see Fig. 4.8.3.2.-1). The dialog is invoked using the 
General Object Attributes dialog (Move button). You can access this function only 
if the currently selected object's type supports moving objects.

Fig. 4.8.3.2.-1 The Move Object dialog

To move an object: 

1. Select the object you intend to move.
2. From the Edit menu select Object Properties to open the General Object 

Attributes dialog.
3. Click Move to open the Move Object dialog.
4. In the project structure, select the node, which will host the moved object. 

Notice that you can work with the project tree in a normal manner, i.e. expand 
and collapse nodes.

5. On the Move Object dialog, click Move Here to move the object. The Move 
Object dialog closes causing the project structure to collapse. Notice that if the 
Project Structure Navigator detects that the currently selected target node cannot 
host the object you are about to move, you are not allowed to perform the move 
operation. This means that clicking Move Here has no effect.

To cancel moving the object, click Cancel in the Move Object dialog.

4.9. Views menu
The Views menu contains view manipulation functions and the list of user views, if 
such have been created in the current project. For example, in Fig. 4.9.-1 below, the 
project contains one user view, titled User view 1.

Fig. 4.9.-1 The Views menu
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4.9.1. Create View
With this menu option it is possible to create new user views.

createview_1

Fig. 4.9.1.-1 Creating a new view

New user views are created by defining the view name, i.e. the instance name, and 
the view description that is a logical name for the view. The root name is the name 
of the root node in the new view.

Own view colors can be used to differentiate separate projects and/or separate views 
of one project. By clicking the button next to the "Own color" sample color box a 
Color Chooser dialog is opened for selecting a color. The "Default color" option 
reverts to the default light blue color.

ViewColors

Fig. 4.9.1.-2 Defining own view color
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4.9.2. Delete View
This option deletes the current view. Only user views can be deleted, i.e. you cannot 
delete the Master Design View.

4.9.3. View Properties
By selecting this option can the current view�s properties be changed.

prjprop_1

Fig. 4.9.3.-1 The Project Properties dialog

Project properties are the project name, that is the instance name, and the project 
description that is a logical name for the project. The root name is the name of the 
root node in the project view.

The background color for the view can be changed by clicking the button next to the 
"Own color" sample color box, or the default light blue color selected with the 
"Default color" option.

4.9.4. View List
The View List is a list of all views defined for the project. By selecting one of the 
views the navigator changes the active view. Only the Master Design View is always 
available, user views are optional.

4.10. System Tools menu
The System Tools menu contains the tools that are available for use at the CAP 505 
system level.

Fig. 4.10.-1 The System Tools menu
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This menu is customizable. You can modify the contents of this menu by selecting 
the Customize� option (see the next section). By default, menu items for invoking 
the System Configuration Tool, the Plant Structure Settings Tool and the DR-
Collector Tool are available.

For detailed information on the System Configuration Tool, refer to the CAP 505 
Installation and Commissioning manual.

For detailed information on the Plant Structure Settings Tool, refer to Chapter 7. 
Plant Structure object types

For detailed information on the DR-Collector Tool, refer to the Tools for Relays and 
Terminals manual.

4.10.1. Customize...
The Customize� menu alternative, see Fig. 4.10.1.-1, makes it possible to add and 
remove tools to and from the System Tools menu.

Fig. 4.10.1.-1 The customization dialog

By selecting a system tool from the right hand list and clicking <<, the tool is added 
to the System Tools menu. And by selecting a tool from the left hand list and 
clicking Remove, the tool is removed from the System Tools menu.

4.11. Help menu
This menu contains the function for invoking the About dialog of the Project 
Structure Navigator and CAP 505.

MHelp_1

Fig. 4.11.-1 The Help menu
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4.11.1. About Project Structure Navigator
This About dialog contains information about the current version of the Project 
Structure Navigator and the Project Manager.

4.11.2. About CAP 505
Keyboard entry: <F1>

This About dialog contains information about the current version of CAP 505.

The information presented in the About dialog should be available 
when contacting your local support.

The information presented in the About CAP 505 dialog should be 
available when contacting your local support. It can be copied to the 
Windows clipboard in a textual format by clicking the Copy button 
in the About dialog.
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5. Project Export/Import Tool

About this chapter
This chapter describes the Project Export/Import Tool.

5.1. General
The Project Export/Import Tool is used when a project is to be transferred to another 
system or brought into your CAP 505 project collection, which comprises all the 
projects stored under the directory \CAP505\PRJ.

5.2. Starting the Project Export/Import Tool
The Project Export/Import Tool is started from the File menu by selecting Organize 
Projects..., see Fig. 5.2.-1.

Fig. 5.2.-1 File menu with Organize Projects...

The user interface of the Project Import/Export Tool is shown in Fig. 5.2.-2.

Fig. 5.2.-2 The user interface of the Project Export/Import Tool

Table 5.2.-1 presents the project-management functionality provided by the Project 
Export/Import Tool.
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5.3. Features

5.3.1. Updating the project list
The operating principle of the Project Export/Import Tool is first to select a project 
collection to the list view. The project list is updated by choosing the Source... 
button, shown in Fig. 5.2.-2. The project list can be one of the following:

� Your CAP 505 project collection. By default, the project list displays this 
selection.

� MicroSCADA application projects on a logical drive, either a local or a network 
drive.

� Projects stored in an arbitrary user-specified directory.

The project list displays project names in the format APL/ProjectName. When APL 
is CAP 505, it means that the project is in the CAP 505 project collection. Any other 
APL indicates the MicroSCADA application and project name.

The Source... button invokes the following dialog for choosing one of the 
alternatives above:

Fig. 5.3.1.-1 The Project Source Directory dialog

Table 5.2.-1 Description of the Project Export/Import dialog buttons:
Close For closing the dialog.
About PEIT... Provides additional information about the tool and 

System Information.
Copy to... For copying projects.
Export... For exporting projects from the CAP 505 project 

collection to an arbitrary user-defined location.
Import... For importing projects from an arbitrary user-

defined location to the CAP 505 project collection.
Properties... Provides information about the project folder.
Delete... For deleting projects from the CAP 505 project 

collection.
Duplicate... For duplicating projects in the CAP 505 project 

collection.
Create... For creating projects in the CAP 505 project 

collection.
Source For defining the Project Source Directory. It can 

be the computer you are using or the 
MicroSCADA environment. You can also define 
the path manually.
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The MicroSCADA APL On Drive and the Path entries allow you to access both the 
local and network computers.

To use the MicroSCADA APL On Drive option, specify the drive letter followed by 
a colon (:), for example 'R:'. The Path entry allows using the Universal Naming 
Convention (UNC) format in addition to the standard format: <drive:>\<directory 
path>. Sample UNC entries are provided below:

Using a share name

\\WORKSTA\Backup\CAP505\Projects

where;

WORKSTA is the name of the target computer.
BACKUP is a share name on the target computer.
CAP505\PROJECTS is a directory path under the share name.

Using the operating system�s administrative share name

\\WORKSTA\C$\Backup\CAP505\Projects

where;

WORKSTA is the name of the target computer.
C$ is the operating system�s administrative share name on the 

target computer, the root directory of the drive 'C'.

Backup\CAP505\ProjectS
is a directory path under the share name.

5.3.2. Project storage
Projects are stored in the PRJS directory in earlier CAP 505/501 releases, for 
example:

<DRIVE:>\SC\CAP505\PRJS

In later CAP 505/501 releases they are stored in the PRJ directory, for example:

<DRIVE:>\CAP505\PRJ

The MicroSCADA application projects are stored under the following directory:

<DRIVE:>\SC\APL\APLNAME\PROTECTION\PRJ

where;

APLNAME is the name of the MicroSCADA application.

5.3.3. Copying projects between network computers
In network environments, projects can be copied from the local computer to/from 
other computers in the network. Other computers are referred to by using their 
computer name, which is a feature of the operating system. You should be granted 
full access to the share name, if the intention is to copy projects to the network 
computer�s project database collection.
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The destination can be one of the following alternatives:

� The CAP 505 project collection on the local computer
� A MicroSCADA library application on a drive letter
� A network directory
� A MicroSCADA library application on a network computer

Notice that, it is up to you to verify before the project is copied that, object types and 
tools in the project are compatible or equal on the remote system. If the project 
contains objects of greater or foreign object types, the remote system may encounter 
problems if the project contains object types of other versions than what is expected 
by the object types and tools. Copying a project does not include the object types.

When a project is copied to a MicroSCADA application, it is copied to the 
application�s PROTECTION\PRJ directory. For example, when the application is 
named PKS, the destination would be \SC\APL\PKS\PROTECTION\PRJ. Since a 
MicroSCADA library application can process one project only, it is named PRJ. For 
example, when a project is copied from a CAP 505 project collection to a 
MicroSCADA library application, it is renamed to PRJ during the copying process.

If a project already exists in the destination directory, you are prompted to replace 
the project or abort the operation. Also, if you enter a destination directory which 
actually is the same as the source directory, you will be notified that the copying 
cannot continue.

Copy To... button brings up the Copy Project dialog shown in Fig. 5.3.3.-1, for 
choosing a destination for the selected project in the project list view.

Fig. 5.3.3.-1 The Copy Project dialog

In Hot Stand-By systems (HSB) it is important that MicroSCADA is 
shut down while the project is being copied.
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Enter the drive designation for the option MicroSCADA APL on Drive in format 
<drive letter><colon>, for example �C:�. Use the letter of the drive on which 
MicroSCADA has been installed.

Enter a network computer name in UNC format, for example '\\L40017\MYPRJ'. In 
this example, the computer name is L40017 and MYPRJ is the share name. The 
option MicroSCADA APL on Network \\Computer\Share refers to the APL 
directory on the MicroSCADA computer, for example '\\L40017\D_root\SC\APL�. 
Press <Enter> when your option is either MicroSCADA APL on Drive or 
MicroSCADA APL on Network \\Computer\Share to update the MicroSCADA 
APL list with the desired MicroSCADA applications.

When you have selected the desired destination, click OK to copy the project to the 
selected destination.

5.3.4. Choosing storage location for temporary projects
Temporary projects mean the compressed projects that have been exported from 
CAP 505 or other product. It is recommended to save such projects in a special-
purpose directory outside the directory structure of CAP 505, for example 
C:\EXPORTS. 

5.3.5. Exporting projects
Exporting a project means that all associated object entries in a project are 
duplicated to some other location specified by you. The destination location can be 
on the local system or on a network drive: the destination location is specified as a 
directory path, for example C:\EXPORTS. The directory path must exist at the time 
you issue the export command.

The output result, in the specified directory, is a compressed archive file with the file 
extension .AR. For example, if the project filename (which also is the actual 
directory name for the project) is KRISTIINANKAUPUNKI then the compressed 
archive file name is truncated to KRISTIIN.AR.

The object types used in the project are not exported along with the project. Hence, 
the functionality in this sense is the same as with copying the projects, as described 
in Section 5.3.3. Copying projects between network computers.

Especially, avoid using the directory \CAP505\TEMP for such 
purpose, since the CAP 505 kernel may choose to erase its contents 
at any time.

When the project is later imported, the full project name must be 
used, although its compressed project filename is only eight (8) 
characters in length.
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Fig. 5.3.5.-1 The Export Project dialog

5.3.6. Importing projects
Importing a project is done in a similar way to exporting, except for the directory 
entry: the source directory is the location from where the project is copied to your 
project collection. The source directory can be a directory on your local computer 
system or on a network drive. The directory entry must be the full directory path to 
the project, for example C:\EXPORTS\KRISTIINANKAUPUNKI would mean that 
a compressed project archive file 'KRISTIIN.AR' is in the directory C:\EXPORTS.

Notice that the project must be specified using its complete project filename, 
although its compressed archive filename is only eight (8) characters in length.

If the compressed archive was distributed to you on several diskettes, you must first 
copy the contents of all the diskettes to a common directory on a hard disk drive and 
import the project from there (see the note in Fig. 5.3.6.-1 below).

Fig. 5.3.6.-1 The Import Project dialog
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The complete filename path is the full path of the exported project archive. For 
example, if a project DEMO was exported to directory X:\EXPORTS, then the 
complete filename path would be X:\EXPORTS\DEMO.AR (if the drive letter X: is 
mounted to the same location on both systems).

Fig. 5.3.6.-2 The communication settings reset dialog

5.3.7. Project properties
The following dialog shows the filename of the selected project:

Fig. 5.3.7.-1 The General Project Properties dialog

The system configuration of the project (i.e. the communication 
settings in the System Configuration and the object level addresses) 
is preserved when the project is imported. If the communication 
settings are obsolete or the current communication environment 
differs too much from the source environment, the communication 
settings of the project can later be reset from the System 
Configuration dialog (see Section 3.8. System configuration in this 
manual). The applicable settings are automatically converted, if the 
source project is detected to have been exported from another 
compatible tool product.
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5.3.8. Deleting a project
Deleting a project is an irreversible operation that cannot be undone.

Fig. 5.3.8.-1 Once you delete a project, you cannot undo it

5.3.9. Duplicating a project
Duplicating a project means that an exact copy of the selected project is copied to 
your CAP 505 project collection. During the process of duplication, you can specify 
a different project name and description. The project filename is actually a folder 
name (directory name), which then will become the project�s home directory. The 
project filename must not already exist.

Fig. 5.3.9.-1 The Duplicate Project dialog

Maximum length of the Project Filename is eight (8) characters.

5.3.10. Creating a new project
Creating a new project is done in a dialog similar to duplicating a project. The newly 
created project is assigned an empty system configuration meaning that you have to 
setup its system configuration by means of the System Configuration Tool. 
Regarding project creation, the same restrictions that apply to the project duplication 
also apply here (see Section 5.3.9. Duplicating a project).

The Project Filename must be a single-word name without spaces or 
characters other than:

A through Z and
0 through 9
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5.3.11. Errors accessing remote disk resources
If you attempt to read/write access to a disk resource on a remote computer, which 
does not contain matching MicroSCADA user account, you will receive error 
notifications illustrated in Fig. 5.3.11.-1 and in Fig. 5.3.11.-2.

Fig. 5.3.11.-1 Notification about a failed export operation

Fig. 5.3.11.-2 Notification about a failed import operation

In order to recover from such a situation, ensure that the target computer's 
MicroSCADA user account is assigned the same password as your local computer.

The notification in Fig. 5.3.11.-2 appears on the screen even if the 
specified project does not exist.
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6. Plant Structure Settings

About this chapter
This chapter describes the functionality of the Plant Structure Settings Tool.

6.1. General
In order to be able to define the attributes for the plant structure object types that are 
applicable to the whole project, this system level tool is available. This tool provides 
the possibility to modify the predefined attributes and define the properties of the 
undefined levels in the object type. For more information on the plant structure 
object types, see Chapter 7. Plant Structure object types

The lowest three levels are disabled because there are no use for them in the CAP 
505/501 environment.

6.2. Starting the Plant Structure Settings Tool
Start the tool by selecting Plant Structure Settings from the System Tools menu in 
the Project Structure Navigator (see Fig. 6.2.-1).

Fig. 6.2.-1 Starting the Plant Structure Settings tool

6.3. Attributes of plant structures
The attributes of the plant structure are applicable to the whole project, i.e. there 
cannot be several definitions of the plant structure�s attributes in the same project. 

Fig. 6.3.-1 Plant Structure Settings dialog
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The attributes that can be modified by means of this tool are:

� Level Id
� Level Description
� Field Length

These attributes are described in more detail in the following chapters.

The default values have been chosen on the basis of the corresponding functionality 
in the MicroSCADA Network Control system.

6.3.1. Level Id
The Level Id attribute defines what the identifier is for recognizing a certain level in 
a plant structure. 

The defaults are:

� STA, that is used for recognizing station level objects
� BAY, that is used for recognizing bay level objects
� DEV, that is used for recognizing device level objects

6.3.2. Level Description
The Level Description attribute is used for describing the different levels in the Add 
Object dialog when an object is inserted.

The defaults are:

� Station
� Bay
� Device

6.3.3. Field Length
The Field Length attribute defines the maximum possible length of the instances� 
names, when adding an object of the plant structure type to the project.

The defaults are:

� 10
� 15
� 5

It is not recommended to change the default values, as it would 
probably cause compatibility problems when e.g. exporting projects 
to MicroSCADA.
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7. Plant Structure object types

About this chapter
This chapter describes the object types included in the plant structure object group.

7.1. Overview
The Plant Structure object types are intended to be used, when building 
MicroSCADA compatible project structures. It is possible to define five structure 
levels, although three of them are predefined. 

7.2. General
The plant structure object types are level sensitive. This means that it is only possible 
to insert predefined objects under each level of the structure. For example, it is not 
possible to insert a bay object under the root level, while it is possible under the 
station level.

7.3. Field length
The length of the instance name in the Plant Structure object type is restricted to the 
value defined for the level in the Plant Structure Settings.

Fig. 7.3.-1 Notification about the instance name length

If the instance name is longer than defined in the Plant Structure Settings, the 
notification shown in Fig. 7.3.-1 appears on the screen. When this happens, the 
correct thing to do is to shorten the instance name to the maximum number of 
characters indicated by the notification.

7.4. Station
The station level is intended to be used in conjunction with a subsequent bay level. 
Highlight the project's root node and select Insert Object from the Edit menu to open 
the Add Project Object dialog (see Fig. 7.4.-1).
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Fig. 7.4.-1 Adding a station level object

Insert the station object by selecting the Plant Structure object group and the Station 
object type. Then, click OK to open the station level object dialog (see Fig. 7.4.-2). 

(Notice that in the Project Structure Navigator's status bar, the displayed object type 
is OI for objects of type Station).

Fig. 7.4.-2 Adding a Station level object

Type in an appropriate name and title for the object and click OK to have the station 
level object inserted.

The name of the object identifies the unique instance as the structure is built up. The 
instance name length is restricted to the number of characters defined in the Plant 
Structure Settings. The maximum length of the name is also displayed on the dialog 

The title of the object is a symbolic description and it is visible in the Project 
Structure Navigator.
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7.5. Bay
Highlight a station level object of a Plant Structure and select Insert Object from the 
Edit menu to open the Add Project Object dialog (see Fig. 7.5.-1).

Fig. 7.5.-1 Adding a Bay level object

Insert the bay object by selecting the Plant Structure object group and the Bay object 
type. Then, click OK to open the bay level object dialog (see Fig. 7.5.-2).

(Notice that in the Project Structure Navigator's status bar, the displayed object type 
is OI for objects of Bay type).

Fig. 7.5.-2 Adding a Bay level object

Type in an appropriate name and title for the object. Then, click OK to have the bay 
level object inserted.

The name of the object identifies the unique instance in the structure. The instance 
name length is restricted to the number of characters defined in the Plant Structure 
Settings. The maximum length of the name is also displayed in the dialog.

The title of the object is a symbolic description and it is visible in the Project 
Structure Navigator.
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8. User Structure object types

About this chapter
This chapter describes the object types included in the User Structure object group.

8.1. Overview
User Structure object types are intended to serve as structurization objects for 
structures that have some other structurization requirements than MicroSCADA 
compatibility. The level structure can be built as deep as is required for the purpose 
intended.

8.2. General
The User Structure object types can be used both in the Master Design View and in 
the user views. 

The main difference between the User Structure object types and the Plant Structure 
object types is that the User Structure does not have the guided insertion order, 
which means that the levels and their purposes are defined by the user.

8.2.1. Inserting Level objects
Highlight a level object and select Insert Object from the Edit menu to open the Add 
Project Object dialog (see Fig. 8.2.1.-1). Notice that in every view, the root node is 
also a Level object.

Fig. 8.2.1.-1 Adding a User Structure object

To insert the level object, select the User Structure object group and then the Level 
object type. Click OK to open the Add Level dialog shown in Fig. 8.2.1.-2.

Fig. 8.2.1.-2 Adding a Level object
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Enter a title for the object and click OK to insert it into the tree structure. The title is 
visible in the Project Structure Navigator and it must be unique in the scope of its 
view, i.e. you cannot have two Level objects having the same title in a single view.
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9. Gateway object types (COM 610)

CAP 505 supports the following gateways:

� LON/SPA Gateway SPA-ZC 100/102 (LSG)
� LON Star Coupler RER 111
� COM 610 communication gateway

The two LON gateway object types are described in a separate LON Gateways 
Configuration manual (see Section 1.7. Related documents). This chapter describes 
only the COM 610 object type.

9.1. General
In CAP 505 the COM 610 communication gateway can be used as a SPA router for 
the following relays and terminals:

� RED 500 series
� SPACOM family

Being a communication gateway, the task of a COM 610 is to make protocol 
conversions between process communication and remote communication. The 
protocol used in process communication is called the master protocol (protocol 
between COM 610 and relay/terminal), and the protocol used in remote 
communication is called the slave protocol (protocol between CAP 505 and COM 
610). In general, the master protocol can be selected irrespective of the selected 
slave protocol.

For the protocol conversions to be possible, cross-references between different 
protocols must be done with the engineering tools provided by COM 610. The 
engineering also includes the mapping of the protocol addresses.

9.2. Supported protocols
Following master/slave protocols supported by COM 610 can be used in CAP 505.

Slave protocols:

�  A COM 610 object can be connected to CAP 505 via SPA router or SPA TCP/IP 
protocol.

Master protocols:

� A COM 610 object allows SPA, LON or SPA TCP/IP protocols to be defined as 
the master protocol for the RED 500 series.

� A COM 610 object allows SPA or SPA TCP/IP protocols to be defined as the 
master protocol for the SPACOM family.

Installation, configuration and usage of a COM 610 communication 
gateway itself is not described here. The documentation and tools 
delivered with the gateway must be utilized.
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9.3. Insertion

COM 610 objects can be inserted only in the Master Design View mode of the 
Project Structure Navigator, and cannot be used in a project's user views. However, 
the device objects hosted by a COM 610 object are normally visible also in the user 
views.

You can insert COM 610 objects into the following locations of a project:

� under the root node of the project
� under a Station object
� under a Bay object
� under a Level object

In contrast to other objects, COM 610 objects are non-movable. This means that 
once inserted, a COM 610 object cannot be moved elsewhere in the tree structure.

The modifiable attributes of COM 610 objects are the same as for the other object 
types (see Fig. 9.3.-1).

Gen_Obj_Attr

Fig. 9.3.-1 General object attributes for COM 610 objects

The SPA TCP/IP master protocol refers to the usage of a 
SPA-ZC 400/402 Ethernet adapter and an IEC 61850 OPC 
server in COM 610.

Adding and using a COM 610 object in a project is mandatory only 
in a situation where the relay is connected to a COM 610 gateway 
with LON protocol. If the devices are using SPA or SPA TCP/IP 
protocol, the device objects can be added to the project with or 
without a COM 610 object.
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9.4. Communication settings
Due to the nature of a communication gateway usage, the communication settings 
for both the master and the slave protocol must be defined separately. Together these 
settings define the complete communication settings of a single relay/terminal.

Since the cross-reference tables between the master and slave protocols must have 
been done for COM 610, also the protocol addresses are mapped. In other words, the 
SPA address of a relay/terminal to be used in CAP 505 is not necessarily the same 
as defined in the physical relay/terminal.

9.4.1. Communication settings of COM 610 object
The communication settings of the COM 610 object can be configured only if the 
project's system configuration contains one or more serial ports or TCP connections.

The communication settings of COM 610 objects are configured on the 
Communication page of the General Object Attributes dialog in the Project Structure 
Navigator (see Fig. 9.4.1.1.-1 and Fig. 9.4.1.2.-1).

9.4.1.1. SPA protocol settings of COM 610 object
When the SPA protocol is used to connect COM 610 to CAP 505, the only required 
definition is the serial port to be used. The SPA address is not applicable for the 
gateway itself.

SPA_pro_settings

Fig. 9.4.1.1.-1 SPA protocol settings for COM 610 objects

SPA addresses behind one COM 610 object must be unique in 
CAP 505.
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9.4.1.2. SPA TCP/IP protocol settings of COM 610 object
When the SPA TCP/IP protocol is used to connect COM 610 to CAP 505, two 
definitions are required:

� TCP connection on the local computer to be used
� IP address of the COM 610 gateway

The SPA address is not applicable for the gateway itself.

SPA_TCP_IP_settings

Fig. 9.4.1.2.-1  SPA TCP/IP protocol settings for COM 610 objects

9.4.2. Communication settings of device object
The communication settings of the device object can be configured only if the parent 
COM 610 object's communication settings have been defined first.

The communication settings of device objects are configured on the Communication 
page of the General Object Attributes dialog in the Project Structure Navigator (see 
Fig. 9.4.2.-1).
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Comm_settings_2

Fig. 9.4.2.-1 Communication settings for RED 500 series terminal with COM 
610 as master.

Irrespective of the protocol to be selected (SPA, LON or SPA TCP/IP), the only 
required definition is the SPA address. All the other LON or SPA TCP/IP addresses 
and port/connection/channel definitions are not applicable for the device objects 
connected to COM 610.

9.5. Using COM 610 object
Here is an example of a configured COM 610 object:

COM610_obj_host

Fig. 9.5.-1 COM 610 object hosting a REC52X object

Address mappings between CAP 505 and COM 610 are based on 
SPA addresses with all the master protocols.
75



76



1MRS752292-MUM CAP 505 
 
User�s Guide
10. Relay Download Tool for REF 54x/REM 54x/
REC 52x/RET 54x

About this chapter
This chapter describes the functionality of the Relay Download Tool, when used 
with REF 54x, REM 54x, REC 52x or RET 54x terminals.

10.1. General
The Relay Download Tool performs bidirectional communication with relay units, 
allowing you to:

� Send Relay Configuration Tool configurations (Relay configuration) to the relay 
terminal.

� Send add-on protocol mapping table (Protocol mapping) to the relay terminal.
� Send transducer linearization file (Transducer linearization) to the relay terminal.
� Send Relay Mimic Editor pictures (Mimic configuration) to the relay terminal.
� Send Relay Configuration Tool projects (RCT project) to the relay terminal.
� Receive add-on protocol mapping table (Protocol mapping) from the relay 

terminal.
� Receive transducer linearization file (Transducer linearization) from the relay 

terminal.
� Receive Relay Mimic Editor pictures (Mimic configuration) from the relay 

terminal.
� Receive Relay Configuration Tool projects (RCT project) from the relay 

terminal.
� Read function block lists from the relay terminal.
� Read configuration counter values from the relay terminal.
� Reset the relay terminal.
� Store the current settings and data in the non-volatile memory of the relay 

terminal.

Due to the fact, that the Relay Download Tool is shared by relay terminals which 
support different capabilities, some features are available only for certain relay 
types. For example sending/receiving of the Mimic Configuration is not available 
for REC 52x relay types, and sending/receiving Protocol Mapping is available for 
only certain REF 54x, REM 54x, REC 52x and RET 54x relay revisions. If some 
feature is not valid for the relay in question, then the feature is disabled in the tool.

10.2. User interface
The Relay Download Tool window contains two pages. The Send page contains 
functions for sending (downloading) data to the relay terminal. The Receive page 
contains functions for receiving (uploading) data from the relay terminal. To switch 
between the pages, click on the page title.
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RDT_Main1

Fig. 10.2.-1 The Relay Download Tool window

10.3. Menu commands
This section describes commands that are available from the menu bar.

10.3.1. File menu
The File menu is used for terminating the Relay Download Tool session.

Fig. 10.3.1.-1 The File menu of Relay Download Tool

10.3.1.1. Exit
By selecting this menu item, the Relay Download Tool session terminates and you 
return to the Project Structure Navigator.

10.3.2. Help menu
The Help menu is used for invoking the Relay Download Tool's About dialog, which 
displays version information.

Fig. 10.3.2.-1 The Help menu of the Relay Download Tool
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10.3.2.1. About
By selecting this menu item you can view the Relay Download Tool's version 
information.

10.4. Relay communication functions
This section describes the relay communication functions.

10.4.1. Send page
Fig. 10.4.1.-1 shows the Send page, which contains check boxes for selecting what 
to download to the relay terminal. The available options are: Relay Configuration 
Tool configurations and projects, protocol configuration file (Protocol Mapping), 
transducer linearization file and Relay Mimic Editor configurations. Downloading 
is executed by clicking the Send button.

If the "Store + Reset after download" check box is checked when clicking the Send 
button, then the Store and Reset commands are sent automatically after a successful 
download of the selected files. These commands are described in Section 10.5. 
Relay command buttons.

RDT_Send1

Fig. 10.4.1.-1 The Send page

10.4.1.1. Protocol Mapping in REF 54x/REM 54x/RET 54x
Certain REF 54x, REM 54x and RET 54x terminal types support so-called add-on 
protocols. Add-on protocol is an optional communication protocol, which can be 
configured and activated separately. Examples of possible add-on protocols are IEC 
60870-5-103, Modbus and DNP 3.0.
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The protocol configuration file (so-called Protocol Mapping) is prepared in advance 
by the Protocol Mapping Tool. Then it can be sent and the protocol is activated by 
the Relay Download Tool. Protocol Mapping check box can be selected only if the 
relay terminal supports add-on protocols, and a certain protocol is selected in 
advance in the object properties for the relay in question. Note that IEC 60870-5-103 
protocol has a fixed mapping in the relay and it needs not to be configured in CAP 
505.

If the Relay Configuration is selected to be sent, then the related Protocol Mapping 
is forced to be sent, too. Note also that a protocol mapping differing from the 
currently active add-on protocol in the relay cannot be sent without sending the 
Relay Configuration also. If trying to do that, then the following message will be 
shown:

Fig. 10.4.1.1.-1 Active add-on protocol mismatch

10.4.1.2. Protocol Mapping in REC 52x
Additional protocols like IEC 60870-5-101, Modbus and DNP 3.0 are fixed in REC 
52x relays, which means that the active protocol cannot be changed. The only thing 
to do with the Relay Download Tool is only to transfer the protocol configuration 
file for the IEC 60870-5-101 protocol.

The protocol configuration file (so-called Protocol Mapping) for the IEC 60870-5-
101 protocol is prepared in advance by the Protocol Mapping Tool. Then it can be 
sent by the Relay Download Tool to the relay. Protocol Mapping check box can be 
selected only if the selected REC 52x relay revision supports the configuration with 
the Protocol Mapping Tool.

The Relay Configuration and the Protocol Mapping can be sent independently of 
each other, unlike with the REF 54x, REM 54x and RET 54x terminals. Note that 
also an empty REC 52x relay contains a default protocol mapping.

10.4.1.3. Starting to send Relay Configuration
If Relay Configuration is selected to be downloaded to the relay, then some 
checkings will be done before starting the file transfer procedure.

Some relay terminal types support storing of configuration information, for example 
title, author, last modification date and last download date of the configuration 
program, and also a bay name. If the selected relay supports this, then the present 
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configuration information is read and shown on the confirmation dialog. New values 
are determined and set automatically based on the Relay Configuration Tool and 
CAP 505 project data.

Fig. 10.4.1.3.-1 Relay configuration identification

After you have confirmed to start the sending, the Relay Download Tool will 
perform the following compatibility checkings: 

� It verifies that the connected relay matches the type and revision set in the relay 
configuration. In case of a mismatch, downloading will not be allowed before the 
settings are correct.

Fig. 10.4.1.3.-2 Relay type mismatch

� It checks that the configuration is compiled after last changes. If the configuration 
has been modified in the Relay Configuration Tool without compiling it, 
downloading is prevented before the project is compiled.
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RCT_conf_not_comp.

Fig. 10.4.1.3.-3 Configuration modified after last compilation

� The selected PLC (processor) type is checked. If the selected processor (relay) 
type in the relay configuration differ from the processor relay in the Relay 
Configuration Tool project, it is not allowed to download the configuration.

.

Fig. 10.4.1.3.-4 Processor type mismatch

When all the checkings have successfully passed, the final confirmation to start 
sending is done. The confirmation dialog contains a warning about the fact that the 
relay parameters are reset to their default values, when downloading a new relay 
configuration.

Fig. 10.4.1.3.-5 Warning about resetting parameters to default values
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10.4.2. Receive page
Fig. 10.4.2.-1 shows the Receive page, which contains check boxes for selecting 
what to upload from the relay terminal. Relay Configuration Tool project, protocol 
configuration file (Protocol Mapping), transducer linearization file and Relay Mimic 
Editor configurations can be selected. Note, that since IEC 60870-5-103 protocol 
has a fixed mapping, its protocol mapping table cannot be received from the relay. 
Uploading is executed by clicking the Receive button.

RDT_Receive1

Fig. 10.4.2.-1 The Receive page

10.4.3. File transfer procedure

10.4.3.1. Progress indicator dialog
Fig. 10.4.3.1.-1 shows a dialog, which is presented during a file transfer procedure. 
The progress bar displays the percentage of the file's size, having been sent to/
received from the relay terminal. The actual filename is also shown.

Fig. 10.4.3.1.-1 The progress indicator dialog
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10.4.3.2. Communication errors
The following error messages may appear during the file transfer:

Incorrect communication settings
The following error message appears when the relay is not responding or some other 
communication error occurs:

Fig. 10.4.3.2.-1 Error message for incorrect communication settings

Relay not responding
The following error message appears when the relay is not responding:

Fig. 10.4.3.2.-2 Error message indicating that the relay does not respond

10.4.3.3. Relay configuration errors
Various other error messages may appear when attempting to download erroneous 
configuration(s). Such configurations contain either features that are unsupported by 
the targeted relay or erroneous settings.

For instance, the following message is shown, when the relay returns an error status 
indicating that an unsupported feature has been applied in the configuration.
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Fig. 10.4.3.3.-1 An unsupported POU (Program Organization Unit) is included in 
the transmitted configuration

If the error message contains only an error code without description, a system error 
has occurred in the relay.

Some relay terminal types support advanced configuration error reporting. After 
downloading the configuration the relay will check that all function block specific 
requirements regarding analog channel configuration and task cycle time are 
fulfilled. If errors are detected, a list containing all discovered errors will be 
presented with the name of the function block that reported the error, and a short 
textual error description.

Fig. 10.4.3.3.-2 Example of error list when downloading incorrect configuration
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10.5. Relay command buttons
This section describes the relay command buttons.

10.5.1. Store
The Store command saves current settings and data into the non-volatile memory of 
the relay. 

When storing is in progress, the relay allows no communication. Attempts to 
communicate with the relay will end in the following notification dialog:

Fig. 10.5.1.-1 Storing in progress

10.5.2. Reset
The Reset command resets the relay.

10.5.3. Counter
The Counter command displays the number of configurations successfully sent to 
and stored in the relay (see Fig. 10.5.3.-1).

Fig. 10.5.3.-1 Number of downloaded and successfully stored configurations in 
the relay.

10.5.4. FB List
The FB List button invokes the dialog for viewing the activated function blocks in 
the relay. The function blocks are listed in ascending alphabetic order.
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Fig. 10.5.4.-1 Activated function blocks in the relay

Notice that you can copy the function block list onto the clipboard by using the Copy 
to Clipboard button.

To close the dialog, click Close.
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11. Relay Download Tool for REX 52x

About this chapter
This chapter describes the functionality of the Relay Download Tool, when used 
with REX 52x terminals.

11.1. General
The Relay Download Tool performs bidirectional communication with relay units, 
allowing you to:

� Send a protocol mapping table to the terminal
� Receive a protocol mapping table from the terminal

At the moment the protocol mapping table for the DNP 3.0 protocol is the only 
configuration you can send to or receive from a REX 52x terminal. The protocol 
mapping table itself must be prepared in advance by the Protocol Mapping Tool. 
Due to the fact that only some revisions of the REX 52x terminals support the DNP 
3.0 protocol, the Relay Download Tool is also visible only for certain REX 52x 
types in CAP 505.

Fig. 11.1.-1 Caution for improper communication settings

11.2. User interface
The Relay Download Tool window contains two pages. The Send page contains 
functions for sending (downloading) data to the relay terminal. The Receive page 
contains functions for receiving (uploading) data from the relay terminal. To switch 
between the pages, click on the page title.

Sending the protocol mapping table to the REX 52x is possible only 
with the SPA protocol via the optical front panel connector. Rear 
connectors (SPA or LON) are not supported for downloading. 
However, receiving the protocol mapping from the REX 52x is 
possible also via the rear connections. If the front panel SPA 
connector is not configured for the connected object in CAP 505, 
this message will be shown at the tool start-up:
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Fig. 11.2.-1 The Relay Download Tool window

11.3. Menu commands
This section describes commands that are available from the menu bar.

11.3.1. File menu
The File menu is used for terminating the Relay Download Tool session.

RDT_REX_File_Menu

Fig. 11.3.1.-1 The File menu of Relay Download Tool

11.3.1.1. Exit
By selecting this menu item, the Relay Download Tool session terminates and you 
return to the Project Structure Navigator.

11.3.2. Mode menu
The Mode menu is used for setting the operation mode of the terminal.

RDT_REX_Mode

Fig. 11.3.2.-1 The Mode menu of the Relay Download Tool

11.3.2.1. Set to Protection Mode
By selecting this menu item, the Relay Download Tool sets the terminal back to the 
protection mode. This menu item is intended only for the situation, when the sending 
of the protocol mapping table is interrupted for some reason and the terminal is not 
automatically set back to the protection mode. The selection of this menu item is 
never needed in normal use.
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11.3.3. Help menu
The Help menu is used for invoking the Relay Download Tool's About dialog, which 
displays version information.

RDT_REX_Help.tif

Fig. 11.3.3.-1 The Help menu of the Relay Download Tool

11.3.3.1. About
By selecting this menu item you can view the Relay Download Tool's version 
information.

11.4. Relay communication functions
This section describes the relay communication functions.

11.4.1. Send page
Fig. 11.4.1.-1 shows the Send page, which contains check boxes for selecting what 
to download to the relay terminal. The only available option for REX 52x is the 
protocol mapping table. Downloading is executed by clicking the Send button.

Fig. 11.4.1.-1 The Send page

During the sending of the protocol mapping table the terminal is set 
to the configuration mode. Due to this, the protection functionality 
of the terminal is not in use during the downloading. This is 
indicated by showing this confirmation dialog after the Send button 
is clicked, and before the actual sending begin
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Fig. 11.4.1.-2 Warning about setting the protection mode off

After you have confirmed to start sending the protocol mapping table to the terminal, 
the type and revision of the connected terminal is verified against the selection made 
in CAP 505. Both the hardware configuration and the standard configuration must 
match. If there is a mismatch in the hardware settings, the file transfer operation is 
cancelled and this message will be shown:

Fig. 11.4.1.-3 Hardware configuration mismatch

If there is a mismatch in the standard configuration settings, this message will be 
shown:

Fig. 11.4.1.-4 Standard configuration mismatch

11.4.2. Receive page
Fig. 11.4.2.-1 shows the Receive page, which contains check boxes for selecting 
what to upload from the relay terminal. The only available option for REX 52x is the 
protocol mapping table. Uploading is executed by clicking the Receive button.
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Fig. 11.4.2.-1 The Receive page

Before starting the file transfer procedure, the same hardware and standard 
configuration checking is done (like when sending). If a mismatch in the settings is 
found, a message will be shown and the file transfer operation will be cancelled.

11.4.3. File transfer procedure

11.4.3.1. Progress indicator dialog
Fig. 11.4.3.1.-1 shows a dialog, which is presented during a file transfer procedure. 
The progress bar displays the percentage of the file's size, having been sent to/
received from the relay terminal. The actual filename is also shown.

Fig. 11.4.3.1.-1 The progress indicator dialog

By clicking the Stop button, the file transfer operation is aborted.

11.4.3.2. Communication problems
Some communication problems may appear during the file transfer operation. 
Depending on the situation and the severity of the problem, two kinds of messages 
may be shown: one with the options to retry or cancel the operation, and the other 
without an option to continue.
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Fig. 11.4.3.2.-1 Incorrect communication settings message

Fig. 11.4.3.2.-2 Communication time-out message
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12. Transducer Linearization Tool

12.1. General
The Transducer Linearization Tool is a tool for setting input scaling/linearization 
data of the RTD/analog module (RTD1) in the RED 500 platform terminals. Input 
scaling/linearization is needed when non-linear sensors, not directly supported by 
the RTD/analog module, are used. Linear/non-linear scaling is done to each RTD/
analog input separately. The tool is available only for certain RED 500 platform 
terminals. The first terminal type having this support is RET 54x release 3.0. The 
tool is used for the following tasks:

� Editing input scaling/linearization data
� Exporting input scaling/linearization data to a text file
� Importing input scaling/linearization data from a text file
� Printing transducer input linearization curves

Uploading/downloading of the input scaling/linearization data is done by using the 
Relay Download Tool and the setting of relay parameters is done by using the Relay 
Setting Tool. For more information about uploading/downloading to the terminal, 
refer to Chapter 10. Relay Download Tool for REF 54x/REM 54x/ REC 52x/RET 
54x in this manual. For more information about setting relay parameters, refer to the 
Tools for Terminals and Relays manual. For more information about the RTD/
analog module, consult the technical reference manual for the product in question. 

12.2. Start-up
The Transducer Linearization Tool is started from the Project Structure Navigator. 
Before starting the tool, the desired relay object should be selected in the project 
structure tree. 

The tools that are available for the selected object appear on the Object Tools list, as 
shown in Fig. 12.2.-1. The Transducer Linearization Tool is available as an object 
tool in the Project Structure Navigator for a relay object if the relay type supports 
input scaling/linearization. 

The Transducer Linearization Tool can be opened by double-clicking its name on 
the list.
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TLT_start

Fig. 12.2.-1 Starting the Transducer Linearization Tool from the Project Structure 
Navigator.

12.3. User interface
The main view of the Transducer Linearization Tool is shown in Fig. 12.3.-1.

TLT_main_view

Fig. 12.3.-1 The main view of the Transducer Linearization Tool
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The main view contains the following elements:

� Menu bar
� Toolbar
� Transducer Linearization view
� Status bar

12.3.1. Menu bar and toolbar commands
The menu bar contains the following commands:

� File
� Import�
� Export�
� Print Setup�
� Print
� Exit

� Edit
� Cut
� Copy
� Paste
� Delete

� Help
� Linearization Tool Help
� About Linearization Tool

Table 12.3.1-1 explains the functionality of the commands and the corresponding 
toolbar buttons.

Table 12.3.1-1 Menu bar and toolbar commands:

Command: Toolbar button: Functionality:
File - Exit Exits from the tool
File - Import Imports input scaling/linearization data
File - Export Exports input scaling/linearization data
File - Print Setup Opens the Printer Setup dialog

File - Print Prints transducer input linearization 
curves

File - Cut Cuts selection into clipboard

File - Copy Copies selection into clipboard

File - Paste Pastes the clipboard contents
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12.3.2. Transducer linearization view
The view consists of eight pages, each of which corresponds to an RTD/analog 
input. An individual linearization curve can be created for each input.

The following parameters are used for each linearization curve:

� Description, optional text for describing the input linearization curve
� Table consisting of up to ten pairs of input value/scaled value for the input

The RTD/analog input linearization curve being edited is drawn in a graph picture. 
Only the table values can be uploaded/downloaded from the relay. The description 
text is used internally in the Transducer Linearization Tool only.

12.3.3. Status bar
When a transducer linearization is shown, the status bar contains the following 
information:

� Date and time stamp of the transducer linearization file upload

12.4. Using Transducer Linearization Tool
In order to use the Transducer Linearization Tool for the selected terminal object, its 
RTD/analog module configuration parameters need to be set in the Relay Setting 
Tool. All inputs having its input mode parameter set to the off state will be disabled. 
Inputs having its linearization curve parameter set to the disabled state will have all 
its controls dimmed. The following terminal parameter settings must be considered 
before using the Transducer Linearization Tool:

� Input mode (F016V01x)

Depending on the Input mode, one of the following:

� Voltage range (F016V02x)
� Current range (F016V03x)
� Resistance range (F016V04x)
� Temperature range (F016V05x)
� Linearization curve (F016V09x)

Above, 'x' denotes the input number of the RTD/analog module and input 
linearization curve page in the transducer linearization view.

12.4.1. Reading and saving transducer linearization data
Input scaling/linearization data of the currently selected relay object is automatically 
read when starting the Transducer Linearization Tool. If there is no input scaling/
linearization data to be read, all input pages will have an empty table.

File - Delete Deletes selection

Table 12.3.1-1 Menu bar and toolbar commands:

Command: Toolbar button: Functionality:
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When exiting the tool, input scaling/linearization data will be saved for the current 
relay object. The user is asked for confirmation before the saving is done. If any 
input contains invalid data, the user is prompted to cancel the save operation or to 
return to the input curve page having erroneous data and to correct the values.

12.4.2. Editing transducer linearization data
Each input linearization curve page consists of a description field and a table 
containing input values and scaled values for the input (see Fig. 12.4.2.-1). Editing 
the description field is optional and it can be left empty, whereas the table must 
consist of at the minimum of two and at the maximum of ten rows of valid input 
value/scaled value pairs. 

TLT_example

Fig. 12.4.2.-1 Example of editable transducer linearization data

Input scaling/linearization will be done for the input range entered into the table. In 
order to include the whole input range, include input value/scaled value pairs for the 
least and greatest input range.

The input linearization can be edited by changing or entering values in the table. 
Only valid values can be entered in the table. A valid input value is a value that is in 
the input range shown in the input values column title. The input range is determined 
by the input range parameter selection that is done in the Relay Setting Tool. A valid 
scaled input value is a value in the range [-10000�10000]. 

Start to enter or change a value by clicking in a cell of the table. A value in the left 
cell must have a corresponding value in the right cell, otherwise the value will be 
erased. The curve is immediately redrawn after the value in the right cell has been 
edited and the cursor moved to another cell. 

The table is automatically sorted according to the left column. To enter a value in 
the middle of the table, just append a row to the end of the table having an input 
value in between already entered values.
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12.4.3. Exporting transducer linearization data
The Export function is used when transferring input scaling/transducer linearization 
data between relay objects. The data is saved in a text file, which name can be 
entered or selected from an export dialog, which is opened from the Export 
command in the File menu.

12.4.4. Importing an exported transducer linearization data
The Import function is used when transferring input scaling/transducer linearization 
data between relay objects. The data is read from a previously exported input 
scaling/linearization data file, which name can be entered or selected from an import 
dialog, which is opened from the Import command in the File menu.

12.4.5. Printing transducer input linearization curves

The transducer linearization can be printed to any printer defined in the operating 
system. After selecting File - Print Setup from the menu, the standard Print Setup 
dialog of the operating system appears on the screen. Any available printer can be 
selected and the printer settings can be configured as needed before the printing. 

After selecting File - Print from the menu or by clicking the corresponding toolbar 
button, a print dialog will be opened (see Fig. 12.4.-1) in which current linearization 
curve page or all linearization curve pages can be printed. Confirm printing by 
pressing the OK button or cancel the printing by pressing the Cancel button.

Values in the table can be selected by pressing down the left mouse 
button and by dragging the mouse. The selection can be cleared, cut 
or copied to the clipboard for pasting in other RTD/analog input 
curve pages or other application programs. To do this, click the right 
mouse button at the selection and choose the wanted command from 
the pop-up menu. Alternatively choose the command from the 
toolbar or Edit menu.

Table 12.4.-1 Print and Print Setup functions:

Selection Functionality:
Print Setup Opens a dialog in which print setup for the paper as well as for 

the printer can be defined.
Print Opens a dialog in which it is possible to select printing of the 

current linearization curve or all linearization curves. Printed 
output of the linearization curve pages is similar to what is 
displayed on the screen.
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TLT_print

Fig. 12.4.-1 Print dialog
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